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What's Included
The ArchiCAD MasterTemplate is made up of the following:

1. ArchiCAD MasterTemplate.TPL (a blank template file that you will customize,
then use to start your next project)

2. AMT SAMPLE.PLN (an example demonstration project) with an accompanying
SAMPLE PROJECT LIBRARY folder

3. AMT SAMPLE REMODEL-ADDITION.PLN (an example remodel project)

4. MasterTemplate LIBRARY (a folder containing the main supporting library, 
modules and other resource files)

5. NEW PROJECT FOLDER (a folder structure for project data; you will clone this 
every time you start a project) 

6. MasterTemplate NCS-UDS (National CAD Standard - Uniform Drawing 
System) is a version of the MasterTemplate.TPL and LEGEND MODULE that 
conforms to the layer name system in the U.S. National CAD Standard.

Download and Installation
These files and folders have been compressed into one large Zip file, and as several 
separate smaller Zip files, that can be downloaded from the Bobrow Consulting Group
ArchiCAD Forum website.

1. In your favorite browser, go to the BCG Forum: http://www.bobrow.com/forum

2. Sign in using the login name and password supplied to you when you purchased 
MasterTemplate. 

3. Click on the FORUMS tab at the top of the window, then in the MasterTemplate 
section, click on the ArchiCAD MasterTemplate Download item, which opens up 
a web page with download links.

4. Right-click the main DOWNLOAD link and choose "Save Target As" or "Copy to 
Desktop" or similar. Save the file ArchiCAD_MasterTemplate_1.1.ZIP to your 
Desktop or to any desired location. 
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• Alternatively, you may download the separate zip files for the ArchiCAD 
MasterTemplate, SAMPLE, and the AMT FOLDERS. 

The FREE TEXTURES and FREE LIBRARY PARTS downloads are 
optional. They are bonus items that are not actually used by the 
MasterTemplate.

The NCS-UDS version of the template is an optional download. It is 
exactly the same as the standard template, but with layer naming based 
on the U.S. National CAD Standard / Uniform Drawing System.

• Note: the Master Template version is indicated by the number just before 
the .ZIP extension (e.g. "1.1").  These files are occasionally updated, so 
please check back periodically to make sure you have the latest version.

5. Unzip or expand the Zip file into a folder.  The location of the extracted files can 
be moved later if required, however they should remain within one folder in a 
logical and accessible location.

If you downloaded the separate smaller Zip files, extract them all into one folder, 
and organize them as shown below (this screenshot shows all the items, 
including optional ones):

6. A good place for this template folder is inside your Jobs folder, alongside your 
Office Library (where you keep ArchiCAD components used in multiple projects) 
and other reference resources. In a larger office, this should be on the file server 
so that everyone has access to the latest version of the template and other 
shared materials.

It is recommended that you make backup copies of all template and support files for 
your protection.
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How to Get Started -
A Tour of the ArchiCAD MasterTemplate
You are now ready to begin using the ArchiCAD MasterTemplate and supporting files.

1. Start by opening the MasterTemplate SAMPLE.PLN file to see how we have set up 
and organized this system. We assume that you have a basic knowledge of project 
navigation and the menu structure within ArchiCAD 11.

2. Warning messages may appear when the sample file is opened the first time. 

a. If you get a Library Loading Report:

or

you will need to manually load the MasterTemplate Library in File menu / 
Libraries and Objects / Library Manager. Navigate to the location where the 
template files have been downloaded and extracted, highlight the 
MasterTemplate Library and SAMPLE PROJECT LIBRARY folders on the 
left side, then click the "Add" button:
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To avoid having to do this again later, simply resave the MasterTemplate 
SAMPLE.PLN, which will record the location of the library for the next time. 

TIP: This warning will not come up at all if you place the MasterTemplate 
SAMPLE.pln, the MasterTemplate LIBRARY and MasterTemplate SAMPLE 
PROJECT LIBRARY folders into one containing folder, next to each other (as 
illustrated earlier).

b. Any other warning messages may safely be ignored - keep clicking OK or 
Skip or the Close button on any warning dialog or report window.

However if you wish, you may clean these by following the instructions in 
Appendix A.

3. As you review this sample project, you'll see how the structure of the ArchiCAD 
MasterTemplate is set up. Everything except for the building model and annotation is 
actually in the template: the View definitions (and their associated Layer 
Combinations and Model View Options), the interactive schedules, the Layout 
sheets and even the Drawings placed onto the sheets. Essentially, you can replace 
the building with one of your own (as long as you use the proper Layers) and it will 
appear on the Layouts ready to plot!
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4. In the Project Navigator, use the View Map (second button at the top, to the right of 
the Project Map button) and double click to open the pre-defined Views to see the 
various ways drawings are setup and displayed.  Also review the interactive 
schedules to see their setup.  Further, note the hierarchical folder structure of the 
View Map in contributing to simplified workflow.

5. Continuing in the Navigator, browse the Layout Book (third button at the top) and 
review the pre-defined Layouts in the list that appears as well as the pre-defined 
sheet numbering system.

6. With the Layout Book selected, double click to open each Layout Sheet and review 
pre-placed drawings.

7. Review pre-defined Autotext by selecting the File Menu / Info / Project Info
command.  These Autotext entry fields control text placed onto the title sheet as well 
as the title block.  

TIP: When you are working on your own projects, its best not to change the Autotext 
"content" directly on the layout or master sheets. Instead, update the Autotext in the 
Project Info menu by clicking the small triangle that appears when you select a list 
item:

The asterisks (***) can safely be erased when you fill in actual project data. They 
have been used to make it easier to see uninitialized Autotext values on the title 
block Master or any Layout.
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Template Configuration (first time use)
Open the blank template file ArchiCAD MasterTemplate.TPL. If you get any warning 
messages, follow the same procedure as when opening the sample project.

The first time you open this template, it contains ‘place holders’ for your company 
information and other boilerplate text. The placeholders are identified as text boxes with 
grey backgrounds. These may be edited in the Title Block area of the Master Layouts,
or directly on the Title Sheet and other Layouts.

Systematically go through the various Master Layouts that you intend to use (you can 
ignore Masters with sheet sizes that are not relevant) and fill in your company 
information and logo to "make it your own."

TIP: To simplify a transition from another CAD system, you may import your old 
title block as a drawing (File menu / External Content / Place External Drawing…) 
on either a blank layout or a Master, then explode it (Edit menu / Reshape / 
Explode).

Carefully delete anything you don't need from your old title block (for example, 
graphics and Autotext that are already included in the MasterTemplate). Get rid 
of placeholders or graphics from the original Master that you will be replacing. 
Then move the desired content into position onto the Master. 

For safety, do this on a copy of a Master. To copy a Master Layout, drag it into a 
new position in the Master list while holding down the Control key (PC) or Option 
key (Mac). To work on the new copy, double-click it in the Master list.

Once you have the Master copy looking the way you like, you may Select All and 
Copy, then go the original Master, Select All and Delete, then Paste. Delete the 
Master copy after you verify that the reworked Master is working correctly.

Flip through the actual Layout pages in the template, and anywhere there is a 
placeholder grey box, fill in what you can. Remember that whatever you place into your 
template will save you time in every project, and will always be editable as needed. 

After you have entered all of your office and boilerplate information, you will ‘Save As’ 
and select ‘TPL’ for the file extension to create a custom made template specific to your 
office.  Name it Project Template.TPL or ABC Architects ArchiCAD Template.TPL or 
anything you wish. We suggest placing this in the same folder as the unmodified 
ArchiCAD MasterTemplate.PLN. 

This process may be iterative: you may work on this and get it partly completed, then 
later return to your Project Template.TPL and edit it further. Each time you will open the 
TPL file directly, and save your changes. Once you have finalized your standard office 
template and saved it as a TPL file, all future template file openings may be performed 
as described below. 
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Starting Your Own Projects
Start up ArchiCAD and choose New File / Use a Template; or if ArchiCAD is already 
running, choose File menu / New… then specify Use a Template. The first time, you'll 
need to browse for your office template file (Project Template.TPL, the one you have
modified to include your office standards):
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Later, you'll be able to choose your new template from the popup list of recent 
templates:

The new file will initially be labeled ‘Untitled’, and require you to ‘Save As’ with your 
desired project name. Make sure when you "Save As" to choose PLN format
(ArchiCAD Solo Project), and name as desired (e.g. 07123 SMITH HOUSE.PLN). Save 
the PLN into its own project folder (e.g. 07123 SMITH) inside your Jobs folder.

You are now ready to begin laying out your building or site. Be sure to review the default 
number of stories and floor-to-floor elevations in the Story Settings Dialog Box under the 
Design Menu, and correct as needed.

Construct the model and site as you normally would. You will have to adjust the 
locations of the pre-placed section and elevation markers.  You may also have to adjust 
the vertical elevation of the special modeling slab to account for the relative relationship 
between the initial adjacent grade represented by the modeling slab, and the first story 
level or project zero.

Additional adjustments will be required for the pre-placed drawings in the Layout Book 
depending on the size of your building.
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Project Folder
You may copy the NEW PROJECT FOLDER whenever you start a project, and it will 
become your actual Project Folder; name this folder and file it as you wish. This Project 
Folder will set up a system for all your project data. Everything related to the project has
a place where it can be filed, making it easy to be organized.

You'll place the actual Project.PLN file at the top level of this folder. Use the Project 
Library folder to store any new library parts that you create specifically for the project, 
such as stairs, door panels or other custom objects.

Feel free to customize this NEW PROJECT FOLDER as you wish, so that it fits your 
preferred organizational requirements. You may prefer to adapt your previous project 
folder structure rather than using the MasterTemplate NEW PROJECT FOLDER "as is". 
The most important thing is that you clone this NEW PROJECT FOLDER whenever you 
start a project, so you always have a well-organized, standardized system for every 
project.

For More Help
Please read the complete ArchiCAD MasterTemplate User’s Manual for a 
comprehensive explanation of the MasterTemplate system. You may download the 
latest version of the manual here:

http://www.bobrow.com/mastertemplate/manual.pdf
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Appendix A - Cleaning Up Initial Warning Messages
1. If you get a message about missing Grid Tool add-on, you may ignore this or choose 

to correct it if and when you wish. The Grid Tool allows you to place grid markers 
(lines and marker bubbles) that show up on all stories as well as in appropriate 
sections and elevations. They are linked much like 3D elements, in that if you move 
a gridline on plan, the matching gridline will adjust in sections and elevations. They 
can also be shown in 3D views to help clarify presentation images.

Correct the "Missing Add-on" message by downloading the free Grid Tool from 
Graphisoft. At any time when ArchiCAD is running, you may go to the Help menu 
and select ArchiCAD Goodies. This will open up your default web browser, and take 
you to the page that Graphisoft provides with a variety of free add-ons. Find the Grid 
Tool, and download the appropriate version for your platform (PC, Mac PowerPC or 
Mac Intel). 

Unzip the downloaded file, and follow the ReadMe instructions to place the contents 
into your Add-ons folder (located in the same folder as the ArchiCAD application). 
The next time you start up ArchiCAD, this add-on will load, and you will no longer get 
a warning message for the Grid Tool.

2. You will get a message saying that "The Source files of some Hotlinked Modules are 
missing…" 

To correct this, after the file has loaded, go to the File menu / External Content / 
Hotlink Manager to re-link the module files:
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Click in the "white space" below the list of module files so that no list item is 
selected, then click the "Read All From…" button:

In the "Browse for Folder" dialog box, navigate to and highlight the MasterTemplate 
Library folder, then click OK.
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You will then see that the Hotlinks status has changed to "OK, Path Changed". 

Click the OK button.

3. After you complete the above noted steps and resave the sample file (or the 
MasterTemplate TPL file itself), the warnings will no longer display the next time you 
open the file. 

NOTE: If you did not re-link the Hotlinked Modules successfully, you will get the 
following message when you save the file:
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You may cancel the Save and go back to step 2 above to correct the problem. 
However, it is safe to ignore this message and click the Continue Anyway button. 
You can re-link the Module files at any time, following the procedure in step 2.


